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Introduction
The Form 1+ is compatible with Firmware 1.4 and PreForm 2.20. Later versions of Firmware 
or PreForm are not compatible with the Form 1+. If you are unable to download compatible 
versions of Firmware or PreForm, please contact Formlabs Support or an authorized reseller 
for additional assistance.

Follow this guide to start printing with PreForm. More than just a walkthrough of how to send 
a digital model from your computer to the printer, this guide outlines all the aspects that go 
into a successful print. Learn how to import a file, support a model, orient a model, detect 
weak spots, adjust different layer thicknesses, and change advanced support settings. Using 
a variety of screenshots and examples to highlight dos and don’ts in 3D printing, you’ll pick 
up best practices to apply in future projects. 

Further information on the Form 1+ can be found on the Formlabs Support website under 
Main Topics > Form 1+. Troubleshooting information can be found in Frequently Asked 
Questions (FAQ).  

Designing a Printable Model
Consider the model’s design as a primary factor for each print’s success. These basic 
modeling guidelines help ensure good prints.

As you design your model in your favorite 3D CAD package, you will want to make sure it 
can successfully be printed. Some 3D CAD models are more difficult to print (and some are 
impossible on any printer). Read our design guide and then follow these basic guidelines 
when designing models for the Form 1+ .

Use Supports
Supports are an important feature to give each part a foundation and structure for accurate 
printing. While printing without supports can be tempting, especially for models with a flat 
surface, these are prone to shrinkage and compression at the layers closest to the build 
platform.

Allow Resin to Escape
A fully enclosed cavity (like a hollow sphere) will inevitably trap some resin inside while 
printing. Design such cavities with a drain hole. We suggest the minimum diameter of drain 
holes to be 3.5 mm.

TIP: To conserve resin and decrease print time, print your model as a hollow object.

NOTICE: This guide only contains information specific to the Form 1+ and PreForm 
2.20.0.

https://support.formlabs.com/s/article/Firmware-Release-Notes#1-4
https://support.formlabs.com/s/article/PreForm-Release-Notes#2-20-0
https://support.formlabs.com/s/new-request
https://formlabs.com/company/partners/
https://support.formlabs.com/s/topic/0TO1Y000006mfMXWAY
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Consider Minimum Feature Constraints
The Form 1+ outperforms other desktop machines with features as small as 300 microns. 
Remember that pushing the limits of small details can result in failed prints. Very thin, wiry 
parts are prone to failure, for example. Of course, PreForm Software will not recognize 
features smaller than 300 microns, meaning they won’t show up in your print.

Use Internal Supports When Printing Internal Overhangs
Overhangs are features that require support during a print. PreForm Software generates 
supports so that an overhang doesn’t fail to print. With the “internal supports” feature, 
PreForm can also create supports for internal overhangs (i.e., features that hang over other 
parts of the model). In order to have PreForm generate internal supports:

•	 Open the Support Generation dialogue.
•	 Click the “Internal Supports” checkbox.
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Consider the Print Volume
Prints have maximum dimensions of 4.9 × 4.9 × 6.5 in (125 × 125 × 165 mm) for the Form 1+. 
PreForm Software will help you resize your model to fit the build volume. For larger parts, 
consider designing them in multiple sections that can be assembled after printing.

Use Single Body (or Mesh) Settings
If your final model is the combination of multiple sub-models, make sure to save it as a single 
body (or mesh) in your CAD package. Otherwise, there may be some irregularities in your 
print if the intersecting layers of the sub-models are not correctly recognized by PreForm 
Software.

Starting a Print
To start printing successfully, take time to learn and use PreForm software to setup each 
model and ensure a successful print.

You’ve set up your printer, filled the resin tank, and installed PreForm Software. You’re ready 
to start printing! Make sure your printer is plugged into a power outlet and connected to your 
computer with a USB cable.

Open PreForm Software
The Print Setup window opens when PreForm launches. Use the material selection drop-
down menus to select the material type and version for the specific print job.

TIP: Select “Current Printer Settings” in the Material drop-down menu to apply the 
material settings last used on the printer. Change the layer thickness setting later by 
clicking “Print Settings” on the bottom bar.
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Formlabs Account Login
Log in to PreForm with a Formlabs account to link print jobs to the account and to enable 
Dashboard notifications for only prints linked to the account. The linked account name also 
appears for print jobs uploaded onto the printer while logged in.

Load a Model
PreForm Software supports STL and OBJ files, which you can export from most 3D CAD or 
animation packages. To load a model, drag and drop it into Preform or select “Open” from 
the File menu.

One-Click Print
Select the One-Click Print option to automatically orient, support, and layout each part. After 
sequentially completing all three print setup steps, PreForm opens the Print dialog window 
to confirm and send the job to a printer, so ensure that you’ve connected and selected the 
appropriate printer type, material type, and layer height before beginning One-Click Print. 
The specific printer can be selected by serial name from the Print dialog.

Change the View
Viewing your model from the correct angle can help you position things in just the right way. 
PreForm offers a couple of ways to control your view.

The View Menu
Hover over the View icon to reveal the view controls. The center icon will always take you to 
the initial view. The other icons rotate your view 90 degrees to the top, sides, or bottom. You 
can use the plus and minus buttons to zoom in and out.

TIP: Select “Current Printer Settings” in the Material drop-down menu to apply the 
material settings last used on the printer. Change the layer thickness setting later by 
clicking “Print Settings” on the bottom bar.

TIP: Right click and drag will rotate the view about the model. Right mouse and shift will 
pan. Use the scroll wheel to zoom in and out.



Using PreForm 2.20 with Form 1+  7

Mouse and Keyboard Controls
Control PreForm using the mouse and keyboard. Type ‘?’ at any time in PreForm to view a list 
of keyboard shortcuts. Learning these keys will make part set-up fast and easy.

PreForm can also be controlled using third-party SpaceMouse hardware. PreForm 
automatically detects the SpaceMouse if the mouse device is connected when PreForm 
opens. Use the SpaceMouse to rotate, zoom, or pan the camera view. The first button on the 
SpaceMouse will reset the camera view, similarly to typing ‘F’ on the keyboard or selecting 
View > Home in the menu bar.

Model List
Use the Model List to find and select individual models in the scene by model name. To show 
or to hide the Model List, select or deselect “Show Model List” under the “View” menu. To 
turn on or to turn off the visibility of a model in the print scene, select or deselect the model 
in the Model List. Only the models visible in the scene will print.

Right-click any model in the Model List to do the following:
•	 View model properties and change the model name.
•	 Duplicate the model in the scene.
•	 Delete the model from the scene.

Model Properties
To view the model properties or to change the model name, right-click any model in the print 
scene or in the Model List and select “Model Properties”.

“Model Properties” displays the following information:
•	 File: This field displays the file name of the original OBJ or STL file.
•	 Name: This field displays the model name, which is also used for the Raft Label. To 

change the model name, click the “Name” box to modify the text. Press Enter/Return 
or click outside the menu to save the new model name. Updating the model name 
also updates the Raft Label.

•	 Layers: This field displays the number of layers in the printed part.
•	 Volume: This field displays the estimated resin consumption for the printed part.
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Toolbar Menu
Select a model by clicking on it. The model will turn blue and display the overlaid 
manipulator sphere with three circular axes to indicate that the model is selected. Once a 
model is selected, use PreForm Software features to manipulate the object.

Size or Scale
Before generating supports, set the size of each model. Use the left toolbar to input size 
values, or click and drag the arrow in the top-right of the manipulator that is overlaid on the 
model. Click the “Size” icon or press the “S” key resize the model from the toolbar. 

Options for adjusting the size of a print in PreForm:
•	 Direct resizing: When any model is selected, click on the the arrow - above and to 

the right of the sphere - and drag to resize the model.
•	 Scale factor: change the size of your model by entering a specific factor from the 

Size toolbar.
•	 Nominal dimensions: Type a specific value into any axis in the Size toolbar to resize 

the model, with all axes’ dimensions adjusting respective to the input value.
•	 Units: Toggle between millimeters and inches from the PreForm Edit menu. 

Configure the unit settings when exporting the file from the modeling program, 
before importing into PreForm.

Orient
Models’ orientation can be adjusted throughout the print set-up process. Note that 
changing the X or Y orientation will require regenerating supports. You can use the 
overlaid spherical manipulator, no matter what tool you have selected on the toolbar to the 
left of the screen. However, clicking on the “Orientation” (shortcut O) icon in the toolbar will 
give you additional options for adjusting the model’s orientation. 

The tools available for adjusting orientation in PreForm are as follows:

TIP: To toggle the visibility of the overlaid manipulator, select “View > Show/Hide 
Manipulators” from the PreForm menu.
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•	 Drag rotation: click to select a model, then click and drag the spherical manipulator 
to rotate the model freely. Select one of the circular rings to rotate the file about a 
singular axis.

•	 From the left toolbar:
•	 Orient Selected: PreForm will compute an optimal orientation for printing.
•	 Plane-orientation: Flip your model along each axis with the shaded cube 

icons.
•	 Axis orientation: Rotate your model precisely by typing specific angles for 

each axis.
•	 Select Base: Select a face to point toward the build platform.

Layout or Translate
Configure prints across the build platform before sending the job to print. Use the toolbar, or 
move any model by clicking and dragging a selected part. Click the “Layout” icon or press 
the “L” key to reorient your view so that you look down on the build platform from above. 
From any tool, move the model around by clicking and dragging the four-directional arrow or 
any part of the model outside of the sphere. Choosing “Layout All” or “Layout Selected” will 
allow PreForm to recommend a layout for the current file set.

Duplicate
While in Layout mode, you can make one or more copies of the selected model by using the 
Duplicates feature. You can print as many models as will fit on the build platform. You can also 
use other PreForm features above to set a different size or alignment in the build area for 
each copy.

Import Other Models
Your printer can print multiple models at once, whether duplicates or different models. Import 
additional models the same way you imported the first model. Remove a model from the 
build area by simply selecting it and pressing delete or backspace on your keyboard. 

TIP: Model orientation can greatly affect the success of your print. Prepare your model 
in an orientation that is best suited for print quality on the axis you care about most. We 
recommend trying auto-orient for optimal results.
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Generate Supports
Almost all models need support structures for a successful print, especially those with 
overhangs. Learn more about what supports do for your model. Click the “Supports” icon or 
press the “C” key to access support structure features:

•	 Generate Selected: Generate supports using the current settings for a selected 
model.

•	 Generate All: Generate supports for all models in your scene.
•	 Advanced: Configure custom settings for flat spacing, raft thickness, slope factor, and 

height above raft.

TIP: For trickier parts, it can take time to find the perfect orientation with optimal 
support settings. Use manual supports to selectively add and remove supports after 
auto-generating.

Printability
When a model is loaded into PreForm, algorithms analyze the model geometry and 
detect areas that may affect the printability, or the likelihood of a successful print. 
PreForm highlights three types of part features that reduce printability: minima, cups, and 
undersupported areas. PreForm runs a printability check for minima and cups before and 
after generating supports. PreForm checks for undersupported areas only after supports 
have generated.

Minima
A minimum point—plural: minima—refers to the lowest local point in any area of a model’s 
geometry relative to the build platform. Unsupported minima may break off the part during 
printing and lead to structural defects, warping, or print failures, all of which can contaminate 
resin, damage the resin tank, or cause resin spills. 

Minima are highlighted in red and will fail without additional support. Resolve unsupported 
minima on models using one of the following methods in PreForm:

•	 Add at least one touchpoint to the lowest part of the highlighted area using the 
Supports tool.

•	 Rotate the highlighted areas away from the build platform using the Orientation tool.
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To switch the printability display for minima in PreForm, use the keyboard shortcut Alt+1 on 
Windows and Option+1 on macOS, or on the PreForm menu bar, click View > Printability 
Display, and select or deselect “Show Minima”.

Cups
“Cups” refer to hollow volumes or cavities in a model. Hollow volumes and concave 
geometries require more careful attention to the print orientation. When the opening of a 
cup faces the resin tank, the cup traps air and resin as the build platform lowers the opening 
of the cup against the bottom of the resin tank. The resulting suction can cause separation 
between printed layers, structural defects, warping, and print failures, all of which can 
contaminate resin, damage the resin tank, or cause resin spills.

Cups that reduce printability are highlighted in orange. To resolve highlighted cups, re-orient 
the model using the Orientation tool so that the opening of the cavity either faces the build 
platform or is rotated at an angle, and then regenerate supports.

TIP: For models that contain internal hollows or are enclosed volumes (for example, a 
hollow sphere), use CAD software to either fill in the hollow or add drainage holes in 
the hollow to minimize suction effects during printing and to avoid trapping resin inside 
the part.



Using PreForm 2.20 with Form 1+  12

Undersupported Areas
“Undersupported areas” refers to areas that may require additional supports to print 
successfully. Undersupported areas are frequently overhangs (also known as “islands”), or 
features that would print without being attached to a raft or another layer.

Undersupported areas are highlighted with a red gradient. The intensity of the red indicates 
the overall impact on printability. A deeper red indicates a print failure is likely while a lighter 
red indicates possible structural defects or warping.

Resolve undersupported areas on models using one of the following methods in PreForm:
•	 Add additional support touchpoints to the highlighted area using the Supports tool.
•	 Rotate the highlighted areas away from the build platform using the Orientation tool 

to reduce overhangs.

Print the Scene
Upload a Print Job
With the printer connected to PreForm, click the orange printer button in the left toolbar to 
access the “Print” menu.

On the “Print” menu, select the appropriate printer by serial name, choose a name for the 
print job, and assign an account name for the job. Click “Log In” to set the account name from 
a Formlabs account. The job name and account name both appear on the jobs list on the 
touchscreen display once the job uploads to the printer.

Log in to an existing Formlabs account to link print jobs to the account and to enable 
Dashboard notifications for only prints linked to the account. Log out to unlink the print job 
from an account. Pay attention to any pre-print reminders or warnings. Ensure the correct 
resin tank and cartridge are installed.

Click “Upload Job” to send the print job to the printer. 

TIP: For a Form 1+, click “Upload Job” once the resin tank is clean and the resin tank is 
filled with resin.
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Complete the File Transfer
Once you click “Upload Job”, PreForm displays a progress bar as each layer of your model 
uploads to the printer. 

Confirm the Print
Confirm the print on the printer. Make sure that your printer is ready to print and then press 
the button on your printer to begin the print. Starting a Print

NOTICE: Do not disconnect your printer from your computer or network connection 
until this process is complete. The file transfer can take several minutes. It is safe to 
disconnect the computer once PreForm confirms the upload of your print.

TIP: For the fastest upload time, wait until PreForm completely uploads the file before 
confirming the print and pressing the button.
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Orienting a Model
3D printing is as much an art as it is a science. For successful prints, learn the best ways to 
optimize each part’s orientation.

XYZ Orientation
There are a few ways that you can change your model’s orientation in the X, Y, and Z axes; 
see the suggestions in sections below for the best recommended orientations. The easiest 
way to rotate a print is to click-and-drag on the spherical manipulator that is overlaid on the 
model. Rotate any model more precisely in one of the three main axes by dragging one 
of the circular rings on the manipulator or by typing specific angles into the boxes in the 
Orientation toolbar. The Z axis rotation can be adjusted at any time - from the Orientation 
toolbar or using the Z axis rotation ring - without affecting the supports; supports must be re-
generated if the X and/or Y angles are adjusted.

The X, Y, and Z rotation angles reset to 0 degrees after applying a rotation. This is because 
PreForm’s orientation tools are relative, not absolute; any rotate change is applied relative to 
the model’s current orientation, not its originating one. To see an example of this behavior, 
load a model and create a duplicate of it. Select the first copy of your model and apply a 
90-degree X rotation, followed by a 90-degree Z rotation. Select the second copy and apply 
the same rotations in the opposite order: 90-degree Z rotation, then 90-degree X rotation. 
The result is different.

Vary Print Locations
Extend the life of your resin tank by placing your models in different locations on the build 
platform each time you print. This prolongs the life of the tank and improves print quality by 
distributing the amount of laser exposure throughout. Use the manipulator’s translate feature 

TIP: If you hover the mouse over the X, Y, or Z rotation box in the orient tool, and move 
the mouse’s scroll wheel up and down, the model will rotate smoothly around the 
corresponding axis.
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or the Layout toolbar to adjust a model’s position.

Select Base
“Select Base…” is an orientation tool that allows you to select a face on your model to point 
down at the build platform. Click “Select Base…” and then click on a specific point on your 
part. PreForm will then rotate your part into position.

Once you click “Select Base…” your cursor will appear as an orange arrow when you hover 
over a model.

The part is rotated so that the clicked area faces the build platform.

This is a quick way to orient parts when you have a definite “front” to your model. Selecting 
the underside as the base can help minimize the amount of post-print finishing you have to 
do, as the support marks will not appear on the cosmetic surface if it faces away from the 
build platform.

Tall Supports on Wiper Side
If printing a larger part at an angle, it is good practice to position the taller supports on the 
wiper side. In PreForm’s default view, the wiper side is the right side of the build platform and 
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is labeled “WIPER SIDE”.

Print Flat Surfaces at an Angle
Flat surfaces with support structures print much more successfully at an angle of at least 
10–20º. You will notice that if you use the automatic orientation in PreForm by highlighting 
your part and clicking “Orient Selected” it will usually position your piece at an angle. After 
each layer, the printer performs a “peel” process, which literally peels the printed layer off 
the elastic surface of the resin tank. The forces involved can distort the extremely thin layer 
of a flat surface mounted on support structures. If a planar surface is oriented at an angle to 
the build platform, there is only a little overhang for each new layer. Furthermore, many thin-
walled parts present significantly less area in any slice when printed at an angle.

TIP: The PreForm view represents an inverted perspective of the printed model. Pay 
attention to the front, hinge, and wiper labels in the layout view when orienting a model.
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Orient to Support Overhangs
Parts print one layer at a time. Features that would print as part of a layer without being 
attached to the base or another section of the model are known as overhangs. Without 
support structures, such a feature would lose itself in the resin! PreForm Software 
automatically generates supports to fix this issue. By default, PreForm will also generate 
internal supports that build from one part of the model to another. You can disable this feature 
by unchecking “Internal supports” in the Supports menu.

Orient to Support Minima
A minimum point—plural: minima—refers to the lowest local point in any area of a model’s 
geometry relative to the build platform. Unsupported minima may break off the part during 
printing and lead to structural defects, warping, or print failures, all of which can contaminate 
resin, damage the resin tank, or cause resin spills.

Minima are highlighted in red and will fail without additional support. To resolve unsupported 
minima on models using the Orientation tool, rotate the highlighted areas away from the build 
platform.
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Orient to Prevent Suction Cups
Cups” refer to hollow volumes or cavities in a model. Hollow volumes and concave 
geometries require more careful attention to the print orientation. When the opening of a 
cup faces the resin tank, the cup traps air and resin as the build platform lowers the opening 
of the cup against the bottom of the resin tank. The resulting suction can cause separation 
between printed layers, structural defects, warping, and print failures, all of which can 
contaminate resin, damage the resin tank, or cause resin spills.

PreForm automatically highlights in orange any cups that may reduce the printability of a 
model. Use the Orientation tool to rotate cups so that the opening of the cavity either faces 
the build platform or is placed at an angle. Regenerate supports after orienting the model. 
Orienting cups at an angle or to face the build platform prevents a vacuum from forming 
between the part and the bottom of the resin tank during printing.

TIP: For models that contain internal hollows or are enclosed volumes (for example, a 
hollow sphere), use CAD software to either fill in the hollow or add drainage holes to 
minimize suction effects during printing and to avoid trapping resin inside the part.
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Save your Work
After all that work orienting your model, you may want to save the layout, or “job”. PreForm 
Software will create a FORM file with all of your settings, making it convenient to reload or 
share the file exactly as you printed it. Do this by selecting “Save” or “Save as…” from the File 
menu.

Supporting a Model
Support structures improve print reliability on Formlabs 3D printers. Learn how to configure 
various print geometries for the best results.

PreForm offers basic and advanced support settings. This segment of our video series 
explains best practices for using PreForm to create support structures and the theory of 
supporting upside-down geometries.

Support Structure Overview
Support structures function as scaffolding for the part during printing. The structures support 
the construction of parts and should be removed after the print is complete.

Supports consist of two core components: a flat raft and vertical shafts.

The raft ensures that the part adheres to the build platform. The support raft includes angled 
edges and rounded areas that aid part removal from the build platform. Squeeze flush cutters 
under rounded areas to lift the part from the platform.

The shafts emerge from the raft and connect to the part through small touchpoints. Remove 
supports by hand or with flush cutters when the print is finished.

Support structures include: (1) touchpoints, (2) scaffolding, and a (3) raft which has (4) raft label 
text extruded on the angled edges.
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Overhangs and Shallow Angles
Using 3D printers to make parts without support structures severely limits the part geometries 
that will print successfully. Because 3D printing is an additive process, in which each layer 
is consecutively added to the previous layer, there must exist some material on which each 
layer can build. Accordingly, each layer can only be slightly larger than the previous layer 
without sagging. From a macroscopic perspective, parts must have steep angles in order to 
print properly without supports. 

The support structures allow for parts to be printed at shallow angles. By touching the part 
via the touch-points along the shallow slope, the support structure gives it added strength, 
preventing unwanted twisting or other deformations. Additionally, the support structures can 
accommodate overhangs that would otherwise be unable to print.

Printing Without A Raft
While PreForm allows models to print without a raft, all parts that print without a raft will show 
Z-axis compression in the early layers. PreForm displays a warning if it detects that a model 
will print directly on the build platform and that the model would print more reliably with 
additional supports or a PreForm-generated raft.

Use the “On Build Platform” feature to resolve the warning when printing on the build 
platform and to enable automatic support generation for models that print directly on the 
build platform.

On Build Platform feature
Use the “On Build Platform” feature to print a model directly on the build platform with 
minimal supports and without a full raft. The “On Build Platform” option is located on the 
Supports menu in the left toolbar.

To print directly on the build platform with the “On Build Platform” option:
1.	 Use “Select Base” on the Orientation menu to orient the model so that a flat surface 

sits parallel to the build platform. Select a flat surface of the model to function as a 
base.

2.	 Select “Print on Build Platform” on the Supports menu.
3.	 Click “Generate Selected” to generate additional supports for the model geometry.
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Considerations for printing directly on the build platform
•	 Choose a flat surface of the model to function as a base: When printing directly on 

the build platform, choose a flat surface of the model to function as a base during 
printing. Ensure that the chosen flat region of the model has a surface area sufficient 
to resist the suction forces experienced by the part during the printer’s peel process. 
Experiment with different flat surfaces of each model to determine the best area to 
function as a base. 

•	 Vertical compression and Z-axis dimensional accuracy: Formlabs printers compress 
the first several layers of every print to ensure adhesion to the build platform. This 
compression shrinks the vertical height of a print’s early layers. When printing with 
a PreForm-generated raft and supports, the compression does not affect the part’s 
dimensional accuracy because the compression only affects the generated raft and 
supports. When printing a model directly on the build platform, expect each model to 
be approximately 0.5 mm shorter than designed along the Z-axis in its first layers. The 
exact compressed height varies between printers.

•	 Early layer unioning: PreForm automatically revises the first 0.75 mm of all on-build-
platform prints to increase adhesion. “Early layer unioning” combines and extrudes 
the shapes - the perimeter and fill area - of all layers contained in the first 0.75 mm 
to ensure that printed parts have a completely flat surface in contact with the build 
platform. Slide the Slicer through the early layers to view the uniform, combined 
geometry.

•	 Model compatibility: The “On Build Platform” feature works best for model 
geometries with at least one flat surface that can face directly parallel to the build 
platform. Shapes without any flat areas, such as spheres or organic shapes, are not 
recommended for the “On Build Platform” feature because these geometries will print 
with slightly flattened base layers due to early layer unioning and compression.

•	 Part removal: Take special care when removing parts printed with “On Build Platform.” 
The flush cutters may chip the part. Separate the part from the build platform at the 
face that is least critical for the part’s application or aesthetics.

Undersupported Models
When support structures are generated, Printability coloring is also added to the model, by 
shading red portions of the model that are unsupported. If a part of the model is a deep red, 
that portion of the model is unsupported and will most likely not print well. If a part of the 
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model is a lighter shade of red, that portion of the model is less-well supported and may have 
structural defects.

Typically a very unsupported region (deep red) is caused by an internal overhang or a feature 
too thin to be supported. In these cases, it is best to activate internal supports or try rotating 
the part to a different orientation. Auto-orient maximizes part Printability and can be very 
helpful for parts with unusual overhangs.

The example part shown here is unsupported and the top of the top arm will fail.

A lighter shade of red is less of a cause for concern. Very often, parts will print well despite 
the coloring. This light red serves only as a warning that there may be issues with the part 
orientation. The sphere shown with a faint red ring will likely print just fine.

A fully-supported part will show no red. Make sure to examine your models closely, to identify 
any odd regions of poor Printability. Try re-orienting the part and generating new supports to 
find the ideal configuration.
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Generate Selected vs. Generate All
When you have positioned multiple .STL files in PreForm, you can generate supports for all 
those pieces at once, or individually for each part.

Generate All
Generate the same type of supports at once for all parts on the build platform by pressing 
“Generate All”. Unless you have changed the Advanced Support Settings, this will use the 
default support settings.
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Generate Selected
In the case where you might wish to vary the advanced support settings for each of these 
parts, and thus generate slightly different supports, you can generate a set of supports one 
part at a time using “Generate Selected”.

Supports and Print Settings Compatibility
PreForm generates support structures based on the selected print settings, which include 
information such as layer thickness, material type, and material version. View and modify print 
settings in the toolbar at the bottom of the screen.

When you save a print job as a FORM file, PreForm saves the print settings and generated 
support structures. Reuse saved support structures and custom support locations when you 
load a FORM file into PreForm.

Opening and Importing FORM files

The “Open Or Import” box appears when you open a FORM file with saved print settings that 
are different from the existing print settings selected in PreForm.

Choose either to open the FORM file as a new job with the saved print settings, or to import 
the file into the existing job and apply the existing job’s print settings.

•	 Click “Open” to clear the existing job and to open the FORM file as a new job. 
PreForm automatically loads the print settings and supports saved in the FORM file.

•	 Click “Import” to import the FORM file into the existing job. The “Import Support 
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Locations” box appears. You can choose either to import the saved support 
touchpoint locations or to delete and regenerate supports.

Importing Support Locations

The “Import Support Locations” box appears if the imported FORM file’s print settings are 
incompatible with the print settings of the existing job.

•	 Click “Import” to maintain the saved support locations on the FORM file while 
regenerating supports according to the print settings for the existing job. PreForm 
only imports touchpoint locations. Use the Supports tool to manually edit the 
touchpoint size and to regenerate supports to match the new material settings.

•	 Click “Delete Supports” to clear all saved support settings from the imported FORM 
file. After the file loads in PreForm, regenerate supports manually using the Supports 
tool.

Adjusting Layer Thickness
Printing is fastest and produces the best prints with the right layer height. Choose the layer 
height with the material settings in PreForm.

You can use PreForm to quickly prepare and print your models without having to tweak an 
endless number of settings. With “0.05 mm” as a great default layer height, you can expect 
flawless prints with almost every model using Formlabs resin. This article looks at when you 
should use the other material settings, such as “0.025 mm” or “0.1 mm”.

Changing the Layer Thickness
You can change the layer thickness by clicking on the button next to “Print Settings” on the 
toolbar at the bottom of PreForm. 

This will bring up the “Print Setup” menu. Here you can set the layer thickness to a particular 
resolution (e.g., 0.1 mm) and the material to a particular type of Formlabs’ resin (e.g., Grey). 
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The layer thickness refers to the height of each layer of resin cured to create your part.  
Since these measurements are fractions of a millimeter, they are often given in terms of 
microns (1 micron = 1 µm = 0.001 mm). To put that in perspective, 100 µm is approximately the 
thickness of a sheet of paper or a human hair; 7 µm is approximately the diameter of a red 
blood cell. The Form 1+ comes with settings for 0.025 mm, 0.05 mm, and 0.1 mm (25 µm, 50 
µm, and 100 µm respectively).

Speed
Thin layers significantly increase print time, when compared to the 0.1 mm layer thickness. 
Change the layer thickness in the Print Setup menu, then select the print time estimator in the 
bottom toolbar to approximate and compare print times with different settings.

When printing at 0.05 or 0.025 mm, the Form 1+ uses the 0.1 mm layer height print for the 
base and early support layers, then the printer switches to the selected layer thickness 
when printing parts of your model. When the base’s raft or supports are large relative to your 
model, these early “coarse layers” can make a significant difference in print time.

Layer Thickness and Print Quality
Traditionally, extrusion-based 3D printers have emphasized the layer height (such as 0.1 mm 
or 0.27 mm) as the main indicator of accuracy or quality. One reason for this may be that 
3D prints made with this technology typically have visible ridges between different layers. 
Smaller layer heights can help to reduce but not eliminate these defects. Layer height alone 
does not determine part quality. See the two rooks to compare the same model printed at 0.1 
mm on the Form 1+ and an FDM machine.
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L-R: FDM Printer at 0.1 mm Layers, Form 1+ at 0.1 mm Layers

Images shown at 27x magnification

The 0.1 mm settings produce beautiful, smooth prints and are a great place to start. Because 
the Form 1+ uses a different and more accurate technology to create 3D prints, there’s much 
less need to pursue smaller and smaller layer heights. Without a microscope it is difficult to 
identify Form 1+ parts printed using 0.1 mm layers from parts using 0.05 mm, or even 0.025 
mm layers.

L–R: 0.1 mm, 0.05 mm, and 0.025 mm Layers

TIP: Keep print time in mind! 0.1 mm prints finish in roughly a quarter the time of prints 
with 0.025 mm layers.



Using PreForm 2.20 with Form 1+  28

L–R: Print time approximately 2 hours, 4 hours, and 8 hours.

When to Use 0.025 mm
The Form 1+ can be used to capture incredibly small details in your model not possible on 
other desktop 3D printers. If you’re not sure which setting to use, then the 0.05 mm setting 
is a great balance between capturing fine detail and having a print finish in a reasonable 
amount of time. The 0.025 mm setting should be reserved for models of exceptionally high 
resolution.

When to Use 0.2 mm
The Form 1+ can also produce reduced-resolution prints at a remarkable speed. This 
resolution is only available when printing with Formlabs Clear resin and is selected through 
the PreForm interface. Our 0.2 mm setting is perfect for moments when speed takes priority 
over surface quality. Printing at 0.2 mm resolution is typically twice as fast as printing at 0.1 
mm and significantly faster than printing with an FDM printer at the same resolution.

L–R: 0.1 mm, 0.2 mm layers.
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L–R: Print time approximately 2 hours, 48 minutes.

Editing Advanced Support Settings
Understanding how to configure each print makes printing easier. Advanced support 
structure options in PreForm offer greater control.

PreForm Software is designed to take the hard work out of generating support structures so 
that you can focus on creating great models and prints. 3D printing is as much an art as it is 
a science, so we’ve designed more advanced support structure options to give you greater 
control. Keep in mind that adjusting these settings can affect your print for better or worse.

Supports Menu
Click the Supports icon (third down in the PreForm toolbar) to access additional features.

The circular arrow button next to the advanced tab will restore the default setting values.
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Density
This slider controls how closely-packed the support pillars are, and also affects how many 
contact points there are between the support structures and your model. Changing the 
density will also adjust the flat spacing value, which measures the distance between 
touchpoints on a flat, horizontal surface.

Touchpoint Size
Touchpoints are the locations where each support connects to the part. By default, this point 
has a smaller radius than the rest of the support structure, which allows for easier removal 
and fewer marks after printing. There are trade-offs to increasing or decreasing the touch 
point size:

•	 Smaller touchpoints make it easier to remove the support structures from the printed 
part, and will leave fewer marks on the build. However, there is a higher chance of the 
supports failing to hold up the part while printing, resulting in print failure.

•	 Larger touchpoints make for more security of the supports during printing, but the 
supports will be harder to remove from the finished part.

Internal Supports
Checking this box will generate supports inside your model, to shore up overhangs and other 
difficult geometries.

Without internal supports, the top legs of the sample table model are unsupported (indicated 
by the deep red region on the PreForm render) and may fail in a build. If this is the preferred 
orientation to print the part, it’s necessary to add internal supports.

TIP: Printing in flexible resin may require higher support density if your model has a 
large cross section. See our guide on Using Flexible Resin to ensure that your flexible 
models print successfully.

NOTICE: Setting the touchpoint size below 0.40 mm may offer smoother print surfaces, 
but parts may separate from supports with a point size below 0.40 mm. For small 
touchpoints, increasing the density value may slightly improve the print quality. Gain 
printing experience and practice identifying critical support positions before lowering 
the touchpoint size.
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With internal supports added, the full structure is sufficiently supported and should print 
without issues.

Raft Label
When generating supports, PreForm also generates the model name on the raft of the model. 
The model name repeats around the raft depending on the size of the raft and the length of 
the name.

To disable the default Raft Label feature in PreForm, click on the Supports tool and deselect 
“Raft Label”.

To edit the Raft Label, right-click the selected model. A pop-up menu appears. Select “Model 
Properties”, and click the “Name” box to modify the Raft Label. Press Enter/Return or click 
outside the menu to save the new model name and to update the Raft Label.

The Raft Label feature in PreForm supports most* language characters.

TIP: As supports are generated or edited, PreForm can help identify regions that may 
require additional support. While the red shading is a tool to guide support “neediness,” 
you may find other support settings to be equally effective.

TIP: Use the Raft Label feature to keep track of different versions of printed parts.
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Editing Supports
PreForm allows support structures to be manually edited. Manual supports are especially 
useful for small features that require support to print successfully. Minima are highlighted 
in red and will fail without additional support. In the example of the snail, the shell required 
manually-added supports in order to be fully supported.

Click “Edit” on the Supports menu to open the Supports editor. Use the Supports editor to 
manually revise the support touchpoints auto-generated by PreForm. Use the pointer, and 
click on the model’s surface to add and remove support touchpoints.

Click “Apply” to save edits.

To modify internal support touchpoints, select “Internal Supports”.

Red shading indicates your model needs additional supports, which can be added manually.

Hovering over a support will turn it red. Click once to remove.

The slicer tool allows you to see inside your model and place internal supports.
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Adding and Deleting Manual Supports
Create supports by clicking on the surface of the model. To remove a contact point, click 
the contact point once. Supports can be added to any visible surface that faces the build 
platform, at intervals of 1.5 mm or larger. When manually adding supports, the touch-point size 
slider works identically to the automatic support generator. You can also edit touch point size 
for individual supports by holding down shift and scrolling on your mouse.

Internal supports can also be added, as long as the cavity or gap is visible and “Internal 
Supports” is selected in the Supports editor. The layer slicer is enabled in manual support 
editing mode, but is upside down to allow visibility into the model.

Editing multiple support touchpoints
Drag the pointer to select multiple touchpoints to apply group edits. Drag the slider, click the 
arrows, or type in a touchpoint size to adjust the point size for selected touchpoints. Press 
the ‘Delete’ key to delete selected touchpoints.

Applying Support Edits
When you are done manually editing the supports, click “Apply” to generate the additional 
supports. Once you exit the support editor, PreForm applies the edits to the model and 
reveals the newly generated supports and modifications to the raft. To continue revising 
individual supports and contact points, re-open the Supports editor.

Flat Spacing
Flat spacing is a measure of the spacing between support pillars. The measurement is set by 
adjusting the density slider. For standard resins, the default support density will generate a 
flat spacing measurement of 5.0 mm.

Slope Multiplier
Adjusting the slope multiplier changes the density of supports for sloped and angled 
surfaces. The default value for the slope multiplier is set to 1.0. The slope multiplier is a 
coefficient that can be set between 0.0 and 5.0 in increments of 0.01.

To change the slope multiplier, on the Supports tool menu, click on “Advanced” to reveal 
advanced support settings. Type the desired slope multiplier or click on the up and down 
arrows to change the slope multiplier in increments of 0.05.

•	 A low slope multiplier (that is, less than 1.0) will generate fewer supports on sloped 
surfaces, with more spacing between supports.

•	 A high slope multiplier (that is, greater than 1.0) will increase the number of supports 
on angled surfaces, with less spacing between supports.

TIP: Use the “Slope Multiplier” feature as an alternative to manually adding or 
subtracting individual support touchpoints for sloped and angled surfaces.
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From left to right: supports generated with the slope multiplier set to 2.0, 1.0, and 0.5.

Raft Thickness
All prints start with a raft that adheres to the build platform. Support structures and the 
models themselves are created on top of the raft layers. When adjusting the raft thickness, 
keep in mind that a thinner raft may affect support structure stability, while a thicker raft may 
be difficult to remove from the build platform. Because of normal compression that occurs 
between the build platform and tank during the first layers, the raft thickness that you set in 
the advanced support settings will usually be between 1.5 mm and 2.0 mm. The default raft 
thickness value is 2.0 mm.

Height Above Raft
“Height Above Raft” indicates the minimum height of support structures, or the shortest 
distance between the part and the raft. The default value and the Formlabs recommended 
minimum is 5.0 mm, and PreForm rejects any value less than 3.5 mm. If the Height Above 
Raft value is too small, supports on parts with large surface areas may fail or deform due to 
normal shrinkage.

Z-Compression Correction
Compression along the Z-axis occurs in the early layers of every print to ensure that a part 
properly adheres to the build platform. Printing directly on the build platform may result 
in a finished part being marginally shorter than designed. “Z-Compression Correction” 
compensates for differences in a model’s height to maintain dimensional accuracy during 
printing. By default, “Z-Compression Correction” is set to a value of 0.75 mm. 

Early Layer Merge
Uneven or bumpy surfaces cannot adhere to the build platform. Without a raft, parts with an 
uneven base fail if they are printed directly on the build platform. Level the base of a model 
to be flat and smooth with “Early Layer Merge” to ensure proper adherence to the build 
platform.
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